
Designing with Class -  Using Inkscape  

4th of July Welded Phrase and Mat 
Tutorial Week One 

Created by Jennie Russ 
Easywishbladers Moderator  

Prerequisites:    

 

You must have downloaded and installed version 0.45 Inkscape.  I recommend this version 
since it is so stable to use. 

 

You must have downloaded and installed Robo Master Version 2.4 or 2.5.  This earlier version 
is necessary if you want to share your file with other members of easywishbladers.  

Purpose of this tutorial:  

 

Learn how to draw curved lines 

 

Learn how to place text on a path 

 

Learn how to thicken a line  

 

Weld your text on path into a single object 

 

Create a dxf file 

 

Load dxf file into Robo Master and create gsd file  

This tutorial is only the first tutorial (Week One) of a group of 3 tutorials that will be presented to you 
in a 3 week period of time.  The first week, we will do this tutorial, the next week we will do Tutorial 
Week Two and the Third week we will do Tutorial Week 3.    When you finish you will have 
completed all three tutorials (Week One, Week Two and Week Three).  At the final completion of 
Tutorial Week Three, you should have a design that looks somewhat like this: 

          



Let s Begin-----  

Open up Inkscape by clicking on this icon  

 
and this screen should display:  

  

Lesson 1:  Learning to create curved Lines:  

The reason why you need to learn how to create curved lines is because in this design you want to 
put the text on a curved path.  There are two methods you can use to create a curved line.  There is 
the easy method using the pencil or the fast method using the bezeir tool.  I highly recommend using 
the bezier tool to make a curved line.  The primary reason is that it creates less nodes on the line.  
Less nodes means a better cut.  Therefore we will use the bezeir tool method.  

Fast Method using bezier tool (highly recommend you try this!)  

The first thing we are going to learn is how to use the bezier tool and create curved lines.  The bezier 
tool can be used to trace objects by clicking around an object or it can be used to bend a line into 
curves.  If you prefer to just click and click and click forming your own line like you would if you were 
tracing an object that is fine.  Everytime you click the mouse with the bezeir tool it creates a node.  I 
use this method when tracing objects I want to cut out.  But, before you give up and do that, let s try 
it my way.  Let s make a curved line with just four mouse clicks.   

Before you start this process, please read the entire section below first.  This will give you 
an idea of what you need to do before you start trying it.  

Let s begin --  Before you start using this tool I just want to let you know that you will be using a 
click and drag method.   That means you will click the mouse and hold it down while dragging the 
mouse.   



Step One:  Click on the Bezeir tool   

 
it is located on the left hand side of the screen about 

the sixth tool from the bottom of the screen (see screen shot in easy method above)  

Step Two:  Now left mouse click on the sheet of paper on your screen and you will see a pen 

symbol display    and now drag (holding down left mouse key) upward at an angle 
toward your right and as you drag you will see a grey line appear.  Drag until the diameter of the 

grey line is about an inch to 2 inches in length and release the mouse key.  This length 
will control the height of your curve.  

Step Three:  Once you release the mouse key (without holding any mouse keys down) move the 
mouse downward and as you do you will see a red line appear bending as you move the mouse 

downward  . Continue moving it downward until you get almost level with the 
first node you created, then left click the mouse key.  

Step Four:  Now drag downward toward your right again about one to two inches and release the 

mouse key and then move your mouse  upward toward the right.  You 



should see the red line appear and once you get the curve the way you like it double click the left 

mouse click to release.  You have now got a curved line.     

You can now tweak the curved line by clicking on the line and you should see the nodes appear.  
Click on the first node and you should see the handles appear.  By moving the nodes or the handles 
you can make adjustments to the curve and make it perfect now.   

 

If you do not see the bezier handles then click on the bezier handle icon  and it will turn the 
handles on to display. Click on and off of this icon and it will control whether the handles will show or 
not.  This is located on the bar at the top of your screen.  See screen print below:  

   

Once you master this, you will use it all the time on so many designs.  I use it when I create ivy or 
any type of vines   I also use it to create different borders on cards.  It is super cool.                      



 
Step Four:  Save the file as an svg file.  To do this, click on File menu and select Save .  See 
screen print below and follow directions:  

  

The save window will display.  Follow the instructions on the screen print below:  

   

Always save after each major process you do.  



  
Lesson 2:  Learn how to place text on a path  

Learning how to place text on a path will open up a whole new world for you.  This is what I call 
awesome power!  Before we begin this lesson open up your file 4thJuly2010 if it is not open. 
.  To do this click on File menu and select open recent .  See screen print below:  

  

You should get this file:  

    

Now pick out a font that is not copyrighted that you would like to use.  I picked the font Cowboys 
because it has thick blocked letters.   Which you can get at: 
http://simplythebest.net/fonts/fonts/cowboys.html  

http://simplythebest.net/fonts/fonts/cowboys.html


Step One:  Now just below your curved line on the screen you are going to type the Phrase 4th of 
July 2010 .  You will do this by clicking on the Text Tool on the left hand side of the screen, the 

third one from the bottom .  This will cause the font and size window to display at the top of 
your screen.  

Step Two:  Select the font and the size of the font you want to use.  See screen print below. 

  

Step Three:  Now just below your curved line type the phrase 4th of July 2010  or whatever you 
want it to say.  Your screen should look like this.  The Phrase should be slightly larger than the length 
of the line.  I find if you do that, the phrase fits almost perfectly on the line you created when we 
perform the next step, placing the text on the path.  

 

Step Four:   Now you are going to select both the curved line and the Phrase at the same time.  The 

way you do this is first click on the select tool  and then click on the curved line making sure the 
arrows are around the curved line, once you see that happen you then hold down the Shift key on 
your keyboard at the same time you going to move your mouse pointer on top of the  4th of July 
2010 phrase then left mouse click on the Phrase.  This selects both objects.  Your screen should look 
like this now: 



  
Note:  An easier method to doing this is to click on the Select tool then take you mouse and hold 
down the left mouse click dragging over both objects and then release the mouse key.  This will 
select both objects as well.  

Step Five:  Now while both of the objects are selected Click on the Text Menu and select put on 
path .  See screen print below  

  

Now your screen should look like this: 

 

Just click the mouse key to release the selection    

Don t forget to save by clicking on the  button at the top of your screen!     



 
Lesson 3:  Learn how to thicken a line:  

In this lesson, we will thicken the line we created in the first lesson and apply Stroke to Path .  Open 
up inkscape and click on File menu and select open recent .  See screen print below:  

  

You should get this file:  

   

Step One:  Click on the select tool and then click on the Phrase.  You should see arrows around 
the Phrase which indicates you have it selected.  Then drag it up above the line.   

Step Two:  Now select the curved line.  With the line selected Click on Object menu and select Fill 
and Stroke

  



 

Step Three:  The Fill Stroke screen will display.  Select the Stroke Style  Tab.  Then select px  and 
then enter 29.000 in the Width and then click on the X to close the window.  See screen print 
below:  

         



 
Your line should look like this now:   

 

Don t forget to save by clicking on the  button at the top of your screen!   

Lesson 4:  Weld your Text on Path into a single Object  

Step One:  

Note:  In this lesson you will apply the  Object to Path  and the Stroke to Path .  Why do 
you do this?  You do this because the width of the line is still the original width.  You apply the 
Stroke to Path to change the width of the line to the width of the stroke that you just made.  

You will then apply the union to weld the entire object together.    

Before you apply the Stroke to Path , you need to select the phrase and now bring it back down 
onto the thick line.  You need to zoom in to make sure there are no spaces between the line and the 
phrase.  Click on the + key on your key board to zoom in.  Left mouse click on the Phrase and drag 
it onto the line ever so lightly making sure there are not spaces between the line and the Phrase.  

Your screen should look like this: 

  

Step Two:  Now select the Phrase and the Line at the same time by holding down the left mouse 
key and dragging it around the entire object.   With the entire object selected, Click on the Path 
Menu and then select Object to Path .  See screen print below:    



  

Now select the Path Menu again and select Stroke to Path  see screen print below:  

  

Now select the Path Menu again and select Union .  This welds the entire object together into one 
object now.  You say well, okay, but it doesn t look any different.  Well, let me show you.  Click on 
the View menu and then select Display mode and then select outline .  See screen print below:  

  

Your screen should look like this below.  You can now see that the Phrase and the line is all one 
object welded together.  



    

It is at this point I would now tweak it by moving the nodes and deleting unwanted nodes.  This will 
be explained in the next tutuorial Week Two.  If you selected thick fonts you should not have the 
problem I have with the character 4  which has a skinny bottom that needs to be fixed.    

To get back to the normal view click on the View menu and then select Display mode and then 
click on Normal .    

After each major process you do it is always a good idea to click on File menu and select Save to 
save your file or just click on the Disk icon on the top of the screen  which saves the file as well.  

Your file should look like this now:    

  

Don t forget to save by clicking on the  button at the top of your screen!  

Lesson 5:  Create a dxf file:  

Save the file as an dxf file.  To do this, click on File menu and select Save as .  See screen print 
below and follow directions:  



  

The save to file screen displays:  See screen print below and follow directions.  

   

When you scroll down to select the dxf file this is the window that you should get:  



  

Lesson 6:  Load the dxf file into Robo Master and create gsd file  

Step One:  Open Robo Master version 2.4 or 2.5 if you want to share your files with other members  

Step two:  Click on File and select load dxf file

         



 
This window should display.  Follow the directions below:  

  

After you click on Open  you should see your file loaded into Robo Master:  

     



 
Now click on File and select Document Settings

    

You should get this screen see screen print below.  Follow the directions on the screen print:  

             



 
Now in this step you need to select the image by left mouse clicking and dragging around the object.  
Once the object is selected then right mouse click and select line settings .   

                            



 
This window will display.  See screen print below and follow the directions in screen print.  

  

Then when the first window closes then click on OK on the second window to close it. 
Now while the Phrase is still selected right mouse click and the following screen will appear.  Follow 
the directions below:  You are going to Select Group to group this Phrase into one Object.  



   

Now select Your Phrase and center it in the Page.  

Now click on save Icon  at the top of the screen.  If you have never saved the file before, then 
the following screen will appear.  Follow directions on screen print below.  

 

You have completed Week One Tutorial. 



    


